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Abstract

This user's manual describes the use of the Forest Stewardship Planning Guide computer program.
This program is designed to help landowners leam, formulate and organize ideas and plans for the
future of their forested lands. Goal options are organized into major topics including ecological
aspects, visual quality, wood production, water quality and quantity, and wildlife. Extensive
hypertexd is used to present information about forest features, their uses and benefits. Information
on forest health is also included. A diskette containing the Forest Stewardship Planning Guide
program is included. The program requires Windows 3.1® to operate.
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Disclaimer

The computer program described in this document is available with the understanding that
the U.S. Department of Agriculture cannet assure its accuracy, completeness, reliability, or
suitability for any purposes other than that reported. The recipient may not assert any
proprietary rights thereto or represent it to anyone as other than a Government-produced
computer program.

The use of trade, firm, or corporation names in this publication is for the information and
convenience of the reader. Such use does not constitute an official endorsement or
approval by the U.S. Department of Agriculture or the Forest Service of any product of
service to the exciusion of others that may be suitable.
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SECTION 1 OVERVIEW

1.4 What You Need {o Read

Regardiess of your computer experience, you should at least browse the following sections in the
Users Manual.
= Daedineg 4 CYwersio:

RFURLLENTIE E vvoiw%w

¢ Section 2 Instaliation
e Section 3 Running The Forest Stewardship Planning Guide

1.2 Purpose of the Forest Stewardship Planning Guide

Being a good steward of forest land is difficuit. The primary purpose of the guide is to provide
exposure to and explanations of a wide range of forest practices used to produce a variety of
benefits from forests. The first step is to determine the goals that the forest owner has for the
forest. The Forest Stewardship Planning Guide program, which runs within the Microsoft
Windows® environment, guides the user through a process of selecting forest stewardship goals.
The program offers a great deal of basic information about forests and their management, along
with menus of possible stewardship goals. This program makes limited recommendations on
how to manage a forest for specific goals and describes the conditions that must be created or
enhanced to accomplish them.

1.3 The Relationship of the Forest Stewardship Planning Guide

to the Northeast Decision Model
The guide is one of several computer programs designed to support good forest stewardship.
The central program is the Northeast Decision Model (NED), a computer-based, decision-support
system being developed by the U.S. Department of Agriculture, Forest Service, Northeastern
Forest Experiment Station. NED will provide site-specific expert recommendations to improve
management for multiple values on forests in the northeastern United States. These expert
recommendations will be based on the full range of resource values, including wildlife habitat,
visual qualities, and watershed and ecological characteristics, as weli as traditional timber and
economic values. This will be accomplished by incorporating the knowledge of many resource
experts into the system, and using that knowledge along with inventory data describing the
present state of a forest management unit, to build prescriptions. These prescriptions define a
path for managing the forest with silvicultural technigues that should accomplish the user's goals.

The process of generating prescriptions for forest management is complex. The first step is to
identify the goals of the forest owner or manager. The guide assists a user in determining what
is wanted from the forest. Because the guide does not use data from a specific forest, it is
unable to detect whether goals conflict directly with each other and cannot make specific stand-
based recommendations.

Once the goals for a forest are identified, the next steps are to: determine the information that
will be needed to support decision making, design an inventory process that will acquire those
data, collect inventory data from the stands, and make the data available to NED through a data
entry process. NED will incorporate all of the current capabiiities of NED/SIPS, ancther initial
product of the Northeast Decision Mode! development effort, for data entry, report generation,
treatment specification, and stand projection; aiso NED will take input for a wide range of
resource goals and generate stand-level prescriptions based on the entire management unit
using expert system technology. Many reports on different analyses of different resources will be
available for comparing aliematives.



1.4 Who Should Use The Forest Stewardship Planning Guide

The guide is intended for use by a wide range of individuals and organizations, including national
and state forestry organizations, forest industries, private organizations, and educational groups.
The design of the program enables the user to gain information about forestry and to make
informed decisions.

1.5 Technical Support {Getting Help)
To make the guide easier to use, help is available in several ways,

« Go through Running The Forest Stewardship Planning Guide provided in Section 3. This will
introduce you o many of the features of the guide.

» Read this User's Manual and keep it handy as a reference as you begin 1o use the Guide.
Lock through the RERDME . boc file inciuded on the distribution disketie, # will include any
last minute updates 1o the guide,

e Finally, if the sources above do not answer your questions, we will be glad to help vou
through any problem you may have with the program. Please contact:

USDA Forest Service

Northeastem Forest Experiment Station
705 Spear Street, P.O, Box 968
Burlington, VT 05402-0968

Telephone: 802-951-6774

Fax: 802-851-6368

1.6 Typographical Conventions
Throughout the User's Manual, special notation is used to represent ceriain keystrokes, In
general, a key name within a square identifies a key that should be pressed. For example:

= the "ENTER" key

© = the "F1" function key
0] = the "Alt" key

f = the "F" key

Cccasionally the program requires you (o press a key combination or sequence of keys., The
following examples explain the difference.

I+ = hold down the key while pressing the [} key.

{%h, 7] = press and release each of these keys in order.

The following conventions are also used.

« File names are typed in uppercase, using a special font. For example: README . DOC
User-entered commands are shown in bold face text.
items from the pull-down menu bar are in Bold face with the hot-key undedined.
items within a pull-down menu are Regular face with the hot-key undedined.

# 2 @



SECTION 2 INSTALLATION

2.4 System Requirements

2.1.1 Hardware

2 MB minimum free hard disk space
388 SX or higher processor

4 MB minimum RAM

A rmouse

A 3-1/2" 1.44 MB floppy disk drive

@ 8 & & @»

2.1.2 Software
PC or MS DOS version 3.0 or higher
&«  Microsoft Windows® Version 3.1 or higher

2.2 Diskette Contents
2.2.1 Contents of instailation Diskette
The installation diskette contains several files necessary to install the Forest Stewardship
Planning Guide onto your hard drive. The following is a listing of the instaliation
diskette. If any of the following files are missing, the instaliation process may fail.

ELZGRP EXE 27,136
EZGRY EZG 526
EZY CEFG 951
EZL HST 177
EZILOGO PCX 22,866
Fspo0ol 22
GLO3S HLP 94,202
GUIDE EAE 672,256
INSTALL EXE 71,020
INSTALL QLB 58,883
OPTIONS HLP 294,778
PCAVIEW EXE 28,611
README DOC 761

2.2.2 Contents of the Forest Stewardship Planning Guide Directory
After successful installation of the Planning Guide, your hard drive will have a directory
(normally C:\F5pG) that contains the following files.

BZGRP EXE 27,136
EZI HST 177
EZGRP EZG 464
GUIDE EXE 672,256
OPTIONS HLF 294,778
GLOSS HLP 94,202
README DoC 761

2.3 Installation Procedures
Follow these steps to install the Forest Stewardship Planning Guide:
1. If you are running Windows, you must exit your Windows session and return to a DOS
prompt.
2. Place the Forest Stewardship Planning Guide installation diskette into your floppy disk
drive.



3. Make that floppy drive the current drive {(fype a: or b fwd ).

4. Type install 54

5. Follow the directions given on the screen.
After instaliation, when you restarl Windows, you will be prompted to update the Program
Manager with the Northeast Decision Model group and iis icons

6. Click on Centinue to add the Northeast Decision Modei group.

SECTION 3 Running the Forest Stewardship Planning Guide

L
m 3.1 Starting the Forest Stewardship Planning Guide

Foraat The Forest Stewardship Planning Guide runs under and follows the conventions of
Planng  Microsoft Windows®. If you need 1o learn how to use Windows, refer fo the Microsoft

Guide  \windows User's Guide. After complete installation, your Windows Program Manager
will include the Northeast Decision Medel program group that includes the Forest Planning Guide
software icon. The Forest Stewardship Planning Guide is started just as you would any other
Windows program, by doubile clicking on the icon.

3.2 Exiting the Forest Stewardship Planning Guide

When running the Forest Stewardship Planning Guide, it is recommended that you exit the
program using the normal exit procedures described below. The normal exit includes an
additional screen of information about forestry practices for your area. The quick exit is provided
so that the user may exit from any screen within the program. If you have selected options from
a resources category or have made changes in a previously saved set of options, you will be
asked if you would like {o save your plans {o a file before you exit.

3.2.1 Nomal Exit

After reviewing the oplions for a particular resource category, you
will be retumed to the "Making Plans” screen (see section 3.5
below). From this screen, click on the exit button.

3.2.2 Quick Exit
When running the Forest Stewardship Planning Guide, you may exit the program from
any screen by clicking the Exit option from the File menu. The short-cut key sequence
is: +[¥, [

3.3 Moving from Screen to Screen

The Forest Stewardship Planning Guide is designed o present
information in an organized, step-by-step fashion. Most of the screens
have an OK! butfon. After reading all information on a screen, or after
choosing a planning option, click on the OK! butfon to advance to the next screen.

3.4 MORE INFO Screens - the Reference Hypertext

The MoRE INFO section i$ a reference section providing a huge amount of information about
forestry concepts, your options, and a glossary. This section automatically displays an additional
window of information each time you make a selection. Read this information. it explains what
your forest will ook tike if you choose (¢ include that particular choice in your plans. The
foliowing is an example of the “Table of Contents™ option from the MORE INFO feature;



File EdR Boolgpark  Help

Directory of Gptons and Information

Optionsg

s Planming and Forest Concepts
ie Traanents Neaded ro Cary Out Your Plans

3.4.1 Green or Underlined Words
Once you are in the MORE INFO section, any word that is green and underlined will send
you to ancther screen of information if you click anywhere on the word. There are two
types of underlines: solid and dotted. Words with solid undedlines will jump to another
page in the MoREe INFO screen and provide extended information. A word with a dotted
underdine will dispiay a small “pop up” window of text, usually a definition of the term.

3.4.2 information about Screens
Information about each screen in the Forest Stewardship Planning Guide is available by
using the More info menu option "More info on this screen”, or by pressing 1.

3.4.3 Information about Selections
Information about each planning selection in the Forest Stewardship Planning Guide is
aveilable by using the More Info menu option "More info on this selection” or by
pressing . This information is displayed automatically whenever a selection is made
uniess the "Automatic More Info” ogtion of the Options menu is tumed off (see section
3.9.2 The Cptions Menu).

3.4.4 Table of Contents
You can move from page to page in the MORE INFO section by clicking on the Contents
button on the menu bar in the MORE INFO window and then choosing where you want {o
go. This screen may be directly displayed from the Forest Stewardship Planning Guide
by using the More Info menu option "Table of Contents” or by pressing [.

345 Glossary
The Glossary in the MoRrE INFO section contains definitions of many natural resource
terms, The Glossary may be displayed by using the More Info menu option "Glossary”
or by pressing F.



3.4.6 Basic Concepts
This section contains a vast amount of information that will help you understand basic
forestry concepts. The information is broken into several different categories. You may
display this section of the MORE INFO at any time by pressing 7.

31.4.7 Printing MORE InFo Screens
You can print the information on most of the pages in the MORE INFO section by clicking
on the Print button in the menu bar of the MORE InFo section,

3.5 The "Making Plans” screen

When starting the Forest Stewardship Planning Guide, after viewing a few introductory screens,
the “Making Plans” screen will be displayed. This screen is the jumping-off point to all the other
parts of the program,

Eile

Optians_ More

Making Plans
Read through the following categortes. Dion't hesitate to explore all of them The
tast oplion you choose befurs leaving each screen 1s the one that will be recorded
85 your plan If you decide to change your mind, go back into the category and ciick
onanew chowce. A check will appesr once you have reviewed a category.

Hurie Flanning and Forest Concep

3.5.1 Resource Category interviews
The buttons on the left are the resource category buttons. Selecting a resource category
button will begin an interview made up of a series of screens explaining management
options relevant to that topic. To begin a resource category, click on the appropriate
button. The resource category inferviews use standard screen layouts, that are
explained below in section 3.6: Selecting goals from the resource categories. After
reviewing a resource category, you will be retumed fo the "Making Plans” screen.

3.5.2 Information interview
The first three buttons in the right are information interviews. There are no options 1o
choose from in these categories. You are strongly encouraged to read this information.
After reviewing the information, you will be retumed to the "Making Plans” screen.



3.5.3 Your Plans

R This button is used to view a list of the plans you have selected
from the resource categories. There are two report screens:
"Summary of Plans” and "Fitting Your Plans Together” where ali
your goals come together to help form a plan. These screens are
explained in section 3.7: Listing your plans and producing reports. From gither of these
two screens, you may retum 1o the "Making Plans” screen by clicking the Making Plans
button. You may revisit any of the resource categories, information sections, or
summaries as often as you like, printing reports for each option you desire,

3.5.4 Exit
: The last button on the "Making Plans” screen is the Exit button,

which is used when you have reviewed the resource calegories
and are finished making your plans. Clicking this bulton will take
A you to the "What's Nexl" screen, which is the final screen of the

Forest Stewardship Planning Guide.

3.6 Selecting Goals from the Resource Categories
The five resource categories that contain stewardship planning options are: Ecological Aspects,
Visual and Scenic Qualities, Water Quality and Quantity, Wildlife, and Wood Production. A

category interview may be selected by clicking on the appropriate butlon on the "Making Plans”

screen. Each resource category interview starts with a title screen 1o introduce the topic, then
continues with additiona! screens showing options for making plans about your forest. These
additional screens are of three types: radio-button screens, check-box screens, and list screens.

Use of all these types of screens is explained below.

3.6.1 Title Screens
Title screens are used 1o introduce a resource category. The following is an example of

the “Wood Production” fitle screen,

WOOD PRODUCTION

This category includes options for producing wood and vatue from wood products.
Think sbout what kind of products you want to grow and how best to measure their
value as you make your choices Your options for measuring the vatue of the wood

products mclude:

> cubic feet;

> board feet;

> periodic income; or
> rate of return

Click on OK to explore more sbout wood production




The title screens give some indication about the planning options you will have in this
interview. If you require more information about this topic, you can use the 7 key for
*More Information about this screen”. Normally, you will click the OK! button to continue
with the interview for this resource category. if you are not interested in defining
planning goals, you may click on "Cancel” and return to the "Making Plans” screen.
Once you decide 1o click the OK! button, you may not return to the "Making Plans”
screen until you have viewed all screens in that resource category.

Note: After you are expenienced with using the Forest Stewardship Planning Guide you
may wish to turn off or suppress the display of title screens. See section 3.9.2: The
Options Menu.

3.6.2 Radio-button Screens
Radio-bution screens are used where you may choose only one option from a list of
selections. This type of screen can be recognized because the selections have round
buttons. When you click on your selection, a smaller solid circle is shown within the
radio button. When you make a selection, any previous selection is turned off. The
following is an example of a radio-bution screen.

You can mfluence the forest cover Lype i several ways: create more variety of
types across the forest, maintam the current forest types, or creste a more uniform
type across your forest.

Whnch one do you prefer?

{ O Create andfor malntain a varety of forest ypes.
® Maintnin current forest types.

1 O Create » more uniform forest type.

g O Mo, thank you,

if you require more information about this screen, you ¢an use the i} key for "More
information about this screen”. When you make a selection, the MORE INFO screen for
this selection s automatically displayed. Once a selection has been made, press the
OKI button to continue to the next screen. You will not be aliowed to continue untif you
have made a selection.

Nofe: After you are experienced with using the Forest Stewardship Planning Guide you
may wish to turmn-off or suppress display of the MORE INFO screen. See section 3.9.2;
The Qptions Menu,



3.6.3 Check-box Scraens
Check-box screens are used where several options can be selected. This type of screen
can be recognized by the square selection buftons. Your selections are indicated by an
"x" within the box. The foliowing is an example of a check-box screen,

Plant Characteristics To Feature

You can change the way a forested area, an edge of s forest, a meadow, or a pond
looks by adding some color, flowers, or plants of different shapes and sizes
Adding new plants or emnphasizing interesting plants that are established, to create
variety in the way the area looks is easy to do

Select as many characteristics as you would like to see.

& Fall coler.

[ Flewers,

[ Frults, seeds.

i Contrasting tollage.
] Contrasting form.
{1 none. thank you.,

You may make as many selections as you desire. Usually, the last check-box is a "none
of the above" type of selection. When this last box is selected, any previous selection is
tumed off. If you require more information about this screen, you can use the 7] key for
"More Information about this screen”. When you make a selection, the MoRrE INFO
screen for this selection is automatically displayed. Once your selections have been
made, press the OK! button to continue o the next screen. You will not be allowed to
continue until you have made at least one selection.

Note: After you are expernienced with using the Forest Stewardship Planning Guide you
may wish to turn-off or suppress dispiay of the MORE INFO screen. See section 3.8.2:
The Cptions Menu.

3.6.4 List Screens
List screens are used where options can be selected from a list of itemns. This type of
screen can be recognized because the selections are listed in a box. Your selections are
highlighted in reverse color. You may make as many selections as the text indicates.
Clicking on an item that is already selected turns its selection off. If you require more
information about this screen, you can use the {7} key for "More Information about this
screen”, When you make a selection, the MORE InFO screen for this selection is
automatically displayed. Once your selections have been made, press the OK! button to
continue 10 the next screen. You will not be allowed to continue until you have made a
selection. The following is an example of a list screen.



A e Op ima More

@

Wildlife Species

Here is a list of species that may be attracted to your forest if you ioprove the
habitat. Please select one, two, or three of the following species.

Heaver

Black bear
‘Lastern bluebird
Northern carding
Eastern chipmunk
White-talled deer
Waud duck

Yeliwbeilied ﬂycatchev
Gray fox

Red fox

Wood frag

Hubted grouse

Nofte; After you are experienced with using the Forest Stewardship Planning Guide you
may wish to turn-off or suppress display of the MORE INFO screen. See section 3.9.2;

The Options Menu.

a7 Lnstmg Your Plans and Producing Reports

Once the "Summary of Plans” screen is displayed, the "Fitting Your Plans Together" screen may
be displayed by clicking on the appropriate bution. From the “Fitting Your Plans Together”
screen, you may click the "Summary of Plans” button to return to that screen.

There are two report screens in the Forest Stewardship Planning Guide:
“"Summary of Plans” and "Fitting Your Plans Together”, You may display the
"Summary of Plans” screen by selecting the "Your Plans” button on the "Making
Plans” screen,

Both report screens have a “Making Plans® button that will return you fo
the "Making Plans” screen.

Both report screens have a "Print Report” button that can be used o
produce hard copy reporis of your plans. Before printing your plans, a
screen is displayed allowing you to sef the Management Area Name and the Location. For an

example of this screen, see section 3.8: Saving Your Plans.
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3.7.1 The "Summary of Plans” Screen

This screen displays a list of the plans you have chosen. The following is an example of
this screen.

More fndo

Summary of Plans

crease he variely of foresitypes.

o spactfic plans for water quality

rovide intonsive protoctions - wellands.

nhance habilat for cold waler fich

nhance habital - eastem bluebinds,

s Enhance hablial- wond ducks.

Chrk on the "mportence”
ool (o set an nporisnce | Tescegdion” Column to sae
vt o7 v sl s Infermetion

The first column is the resource category comresponding to the goal. The second column
is an importance value for the goal. The importance value may be changed by clicking
o the importance column for that goal. The third column contains a button that shows
descriptions of the treatments that may be required {0 meet this goal. The last column is
a brief description of the goa! you have chosen. You may click in the last column to
review the MORE INFO scraen for that selection.

The goals displayed may be sorted either by resource category (as displayed here) or by
importance value. To choose the sorting option, click on the Options menu and choose
Sorting Goals (you may use the hoi-keys +51, [51). A menu will appear where you
may select sorting by category or by importance.

11



3.7.2 The "Fitting Your Plans Together” Screen )
This screen displays a compatibitity chart of your goals, The following is an example of
this screen.

File Qptionz  More info

Fitting Your Plans Together

B Comgmtitde veith v complermont cech otfer,
| Soene effont required to do butie.

The first column is the resource category corresponding to the goal, The second column
is a brief description of the goal. The third column is an abbreviation for the goals. This
abbreviation is also used as the column heading. The rest of the table is a matrix of
symbols that indicate the level of management intensity required to meet both goals at
the same place at the same time. Three levels of management intensity are identified.

This symbol indicates that the two goals are compatible with or complement each
mher They can be met easily on the same piece of land at about the same time, Ofien
treatments used (o enhance one will also enhance the other,

u This symbol indicates that there is some effort required to do both. Careful planning
is needed to meet both of these goals on the same piece of land and at about the same
fime. Treatments for one goal may need to be adjusted to accommodate the other.

This symbol indicates that these two goals require two separate areas. These two
plans can rarely be met on the same piece of land and af the same time. However, you
do have several options. You may want to divide some of the stands in this
management area into two or more stands, then carry out these plans in different stands.
You may wani {o divide the management area into two management areas and carry out
one of these plans in each management area. Or, you may meet one goal over the next
few years and the other in the future,
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3.8 Baving Your Plans
Once you have selected plans from the resource category interviews, you may wish to save
them in a file. Use the File pull-down menu option Save or Save As to save your plans.

Before saving your plans
a screen will be displayed
atiowing you to enter a
Management Area Name
and a Location. These
Directory: CAFSPG fields are for your own
use, and you may enter
anything you desire. The

File Mame:  EXAMPLE SPG [modified)

Management |5, example dats set information will be

Area Name: printed on hard-copy
reports and will be saved

Location: anywhere, USA in the file with your plans.
if you have not saved

your plans to a file, or
you have changed plans
since retrieving them
from the file, the file
name will be followed by "(modified)” indicating that the plans have not been saved to a file. The
standard extension for a file used by the Forest Stewardship Planning Guide is SPG. In the
above example, the goals in file EXAMPLE SPG have been modified since the iast file save.

3.9 The Menu Bar

The menu bar is found across the top of the Planning Guide window. 1t contains three pull-down
menus: File, Options, and More Info. Each menu is discussed below. The underlined letter
may be used with the {ii7] key o access a menu. For example [Z7] &} may be used to display
the File menu,

3.8.1 The File Menu

Open The File menu can be displayed by pressing (i1 +§. The first
Mew four iterns marnipulate the disk files, The Open option will
gavz: retrieve previously saved goals, The New option will clear all
goals chosen during this session. The Save and Save As

Save As options will write your plans 10 3 disk file. See Section 3.8:
File Info Saving Your Plans, for a discussion of disk file naming

- conventions. The File Info option allows you to edit the
Exit , management area name and location using the screen

described in Section 3.8: Saving Your Plans. The Exil selection
will exit the Planning Guide program. For the use of this selection, see Section 3.2.2:
Quick Exit.

3.9.2 The Options Menu

J Title Screens The Options menu can be displayed by pressing
 Automastic More Info Fasi+i51. The Title Screens option alows you to
Sorting G 0’;} s suppress the display of the resource cajlagory tsﬁse
screens. A small check to the left of this selection
Experienced User indicates that the title screens will be displayed
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when a rescurce category is chosen from the "Making Plans® screen. When stanting the
Planning Guide program, the Title Screens oplion is turned on.

The Automatic More Info option allows you to suppress the automatic display of the
MORE INFO Screen whenever a planning option is selected. A small check to the left of
this selection indicates that the MoRE InFo screens will auiomatically display when a
planning option is selected. Even if this option is turned off, the MGRE INFO screen may
be displayed by making your selections and using the 7l key. When starting the
Planning Guide program, the Automatic More Info option is tumed on.

The Sorting Goals option allows the user 1o specify how the plans should be sorted for
display and in printed reports. See Section 3.7.1: The "Summary of Plans” Screen for a
discussion of this option.

The Experienced User option is a quick way of suppressing display of the title screens
and the MoRE INFO screens. Selecting this option will tum off the first two selections. if
the Experienced User option is selected on the title screen, the introductory screens are
skipped, and the "Making Plans” screen is displayed after the title screen.

L3 The More info Menu

More Info on this screen F1
More info on this selection F2
Table of Contents F3
Glossary 4
Basic Concepls F5
Abeut the Forest Stewardship Planning Gulde
About the Northeast Declsion Model

The More Info menu can be displayed by pressing [ai5i+). The first five items on this
menu allow the user to display and access the MORE INFO screens. Function keys are
associated with each of these options. For example, to display the MoRre INFO Glossary
you may press the f key. These items are explained in section 3.4: MORE INFO Screens
- the Reference Hypertexd.
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Appendix A. Management Areas

What are they?

Management areas are collections of forest stands {from one 1o many) for which an
owner can specify one setf of goals. Management areas are usually contiguous, but is
not a requirement.

Forest stands are areas of forest that are reasonably similar in composition and general
characteristics of the vegetation and topography. They are limited in size by areas that
are practical to work with at one lime.

How do you delineate them?

Typically, small private-land holdings have only one or two managemen! areas because
the areas are small and the owners want to achieve whatever benefits they can from the
entire area. Larger land holdings may have more management areas when different
goals can be specified for each.

On most private-land holdings in the Northeast, forest stands should be mapped so that
within any one stand the mix of tree species, the range of tree sizes and ages, and the
topography all are relatively consistent.

Making Plans for a Management Area
The plans you develop for each management area will be stored in a separate file.

Therefore, each management area will have its own file. We recommend that the file
name be the same as the management area name.
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